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Meaningful Use 
 

 
 
 
 
 
 
 

Do you have questions about 
Meaningful Use and how to qualify 
for the federal funding for Electronic 
Health Record (EHR) adoption? 

 
 

BioMedix™ has the answers to 
frequently asked questions. 

 
 
 
 
   
As a physician, am I eligible to participate in 
the EHR incentive program? 
Yes, physicians who participate in Medicare are eligible to 
participate in the program. The incentive is based on 75% 
of the Medicare allowed amount or the maximum 
payment available for each reporting period (see the 
schedule below). 

 
How much is the incentive worth to me? 
There is a total of $44,000 available to Eligible Providers 
(EPs) through the Medicare incentive program. The 
payments will be made based on reporting criteria over 
a 5-year period. The schedule is listed below: 

 
Year 1: $18,000 Year 3: $8,000 Year 5: $2,000 
Year 2: $12,000 Year 4: $4,000 

 
How will I report on “meaningful use”? 
The first reporting period for meaningful use can be any 
90-day period during the calendar year of 2011 or 2012 to 
qualify for all five years’ worth of payments. An EP who 
satisfies the meaningful use criteria for 90 consecutive 
days in the first reporting period using a certified software 
system will be eligible for the incentive program. EPs will 
report through attestation that they are meeting or 
exceeding the meaningful use criteria during this first 
reporting period. To qualify in years two through five, EPs 
will need to report their meaningful use electronically, 
 
 

most likely through a report that will be generated by the 
EHR system. 

 
My software was certified for Certification 
Commission for Health Information Technology 
(CCHIT) in 2008.  Will it now qualify as “certified 
software”? 
No. Only software that has been approved for the ARRA 
2011 standards will qualify for the incentive program. 
CCHIT is one of the certification bodies that were 
approved to test and certify EHR software compliance 
with the ARRA 2011 standards. 
 
What is the purpose of “certified software”? 
Certifying EHR software assures the buyer and end users 
of the software that the technology has the necessary 
security, usability and interoperability to meet or exceed 
the meaningful use criteria required to participate in 
the Medicaid and Medicare EHR incentive programs. 
 
Is EHR adoption mandatory? 
While not mandatory, those who choose to delay or not 
implement this technology are subject to reductions in 
their Medicare reimbursements.  In 2012, those who 
are not e-prescribing will be subject to a 1% reduction, 
followed by a 1.5% reduction in 2013 and 2.0% in 2014 
and beyond. In addition, those who are not utilizing a 
certified EHR in a meaningful way by 2015 will be subject 
to a 1% reduction in Medicare reimbursements, 
ramping up to as much as 5% in 2017 and beyond.
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When can I apply for the EHR incentive money? 
EPs can begin to register for the program in January 
2011.  Meaningful Use attestation began in April 2011.  
Registration and other information regarding the 
incentive program will be available at: 
http://www.cms.gov/EHRIncentivePrograms. Payments 
began in May of 2011. 

 
Does the Computerized Physician Order Entry 
(CPOE meaningful use criterion require that I 
enter all medication orders into my EHR? 
According to the final rule for the Medicaid and 
Medicare Incentive Program, any licensed healthcare 
professional may enter medication orders into a 
patient’s medical record per local, state and 
professional guidelines. In addition, for the remaining 
meaningful use criteria, there are no limitations of who 
must enter information into the health record. 

 
Why would I invest in EHR now? 
Many Physicians have yet to make the leap to Electronic 
Health Records. When the majority decide that the time 
has come, resources at companies both large and small are 
going to be stretched to capacity. Implementing your 
software sooner rather than later gives you the best 
opportunity to have a positive and successful software 
implementation with experienced training staff and well-
trained support departments. 
 
Check with your software  vendor to make  sure they will 
put in writing with a money  back guarantee that  their 
system will allow you to qualify for the incentive program 
so long as you demonstrate its meaningful use. 
 
What are the meaningful use criteria? 
The criteria are broken down into a Core Set of 15 criteria 
and measures, and EPs are being asked to pick 5 more 
criteria from a Menu Set of 10 criteria. See the next few 
pages for a more in-depth look at these criteria.

http://www.cms.gov/EHRIncentivePrograms
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Meaningful Use Criteria−  
15 Core Measures 
 

   Meaningful Use Requirements 
 
Objective Measure TRAKnet™ PM Qualifying Steps  
170.304(a) Use 
Computerized Provider 
Order Entry (CPOE) for 
medication orders 
directly entered by any 
licensed healthcare 
professional who can 
enter orders into the 
medical record per state, 
local and professional 
guidelines. 

More than 30 percent of all 
unique patients with at least 
one medication in their 
medication list seen by the EP 
have at least one medication 
entered using CPOE. 

Add encounter. 

Select Orders tab. 

Select “Prescriptions”, click “Add” button. 

Write script (print or send electronically). 

170.302(b)  

Implement drug-drug 
and drug-allergy 
interaction checks. 

The EP has enabled this 
functionality for the entire EHR 
reporting period. 

TRAKnet™ PM uses the Lexi-Comp 
commercial drug database and the Unique 
Ingredient Identifier (UNII) substance 
registration system to check for drug 
interactions. 

170.302(c)(i) Maintain an 
up-to-date problem list 
of current and active 
diagnoses. 

More than 80 percent of all 
unique patients seen by the 
EP have at least one entry or 
an indication that no problems 
are known for the patient 
recorded as structured data.  

Add diagnoses for a patient or select 
“Diagnoses” in their chart by clicking “Add” 
and selecting “Patient has no diagnoses.” 
Patient must have an encounter during the 
reporting period. 

 

170.304(b) Generate and 
transmit permissible 
prescriptions 
electronically (eRx). 

More than 40 percent of all 
permissible prescriptions 
written by the EP are 
transmitted electronically 
using certified EHR 
technology. 

Add prescription. 

Send electronically to Surescripts®. 

170.302(d) Maintain 
active medication list. 

More than 80 percent of all 
unique patients seen by the 
EP have at least one entry (or 
an indication that the patient 
is not currently prescribed any 
medication) recorded as 
structured data. 

The electronic patient chart within TRAKnet™ 
PM allows for the entry of patient medications 
as structured data using the National Drug 
Code (NDC). 

http://onc-chpl.force.com/ehrcert/CHPLCriteriaDetail?prodid=a0O300000028YmoEAE#critDef4
http://onc-chpl.force.com/ehrcert/CHPLCriteriaDetail?prodid=a0O300000028YmoEAE#critDef4
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   Meaningful Use Requirements Continued 
 

 
Objective Measure TRAKnet™ PM Qualifying Steps  
170.302(e) Maintain 
active medication allergy 
list. 

More than 80 percent of all 
unique patients seen by the 
EP have at least one entry (or 
an indication that the patient 
has no known medication 
allergies) recorded as 
structured data. 

Patient’s Chart > Charting > History > 
Allergies > Click “Add” Button.  
Select specific allergies or select the “No 
known allergies” checkbox. 
Patient must have an encounter during the 
reporting period. 

170.304(c) Record all of 
the following 
demographics: 
(A) Preferred language 
(B) Gender 
(C) Race 
(D) Ethnicity 
(E) Date of birth 

More than 50 percent of all 
unique patients seen by the 
EP have demographics 
recorded as structured data. 

Required patient demographics in the 
patient’s chart: 
Preferred Language, Gender, Race, Ethnicity, 
Date of Birth.  
Patient must have an encounter during the 
reporting period. 

170.302(f)(1) Record and 
chart changes in the 
following vital signs: 
(A) Height 
(B) Weight 
(C) Blood pressure 
(D) Calculate and display 
body mass index (BMI) 
(E) Plot and display 
growth charts for 
children 2-20 years, 
including BMI 

For more than 50 percent of 
all unique patients age 2 and 
over seen by the EP, height, 
weight and blood pressure are 
recorded as structured data. 

Select “Vitals” from the patients chart. Click 
“Add” button.  
Patient must have an encounter during the 
reporting period.  The electronic patient chart 
within TRAKnet™ PM allows for the entry of 
vital signs as structured data.  Once entered, 
vital signs are then used to automatically 
calculate Body Mass Index (BMI) and display 
growth charts for patients. 

170.302(g) Record 
smoking status for 
patients 13 years old or 
older. 

More than 50 percent of all 
unique patients 13 years old or 
older seen by the EP have 
smoking status recorded as 
structured data. 

The electronic patient chart within TRAKnet™ 
PM allows for the entry of smoking status as 
structured data. Patient’s Chart > Charting > 
Quality Measure > click “Add” and select 
“Smoking Status”. 

170.304(j) 
Report ambulatory 
clinical quality measures 
to CMS. 

Successfully report to Centers 
for Medicare & Medicaid 
Services (CMS) ambulatory 
clinical quality measures 
selected by CMS in the 
manner specified by CMS. 

EP must run the Quality Measures report and 
use the data when attesting to CMS or their 
specific state. 
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   Meaningful Use Requirements Continued 
 

 
Objective Measure TRAKnet™ PM Qualifying Steps  
170.304(e) Implement 
one clinical decision 
support rule relevant to 
specialty or high clinical 
priority along with the 
ability to track 
compliance with that 
rule. 

Create and implement one 
clinical decision support rule. 

Only one CDR required. 
Desktop > Tools > Patient Queries.  
Select “Clinical Decision Rules”. Click “Add”.  
Fill in appropriate demographic and other 
conditions of the rule. Click “Save.” 

170.304(f) Provide 
patients with an 
electronic copy of their 
health information 
(including diagnostic test 
results, problem list, 
medication lists, 
medication allergies) 
upon request. 

More than 50 percent of all 
patients who request an 
electronic copy of their health 
information are provided it 
within 3 business days. 

A patient’s electronic health information can 
be exported from TRAKnet™ PM as a 
Continuity of Care Document (CCD) and 
given to the patient in a readable form. 
Patient’s Chart > File > Export > CCD > For 
Patient. 

170.304(h) Provide clinical 
summaries for patients for 
each office visit. 

Clinical summaries provided to 
patients for more than 50 
percent of all office visits within 
3 business days. 

Percentage of all the encounters, within the 
reporting period, where a CCD was exported 
for the patient. 
Encounter > File Export > CCD > For Patient. 

170.304(i) Capability to 
exchange key clinical 
information (for example, 
problem list, medication 
list, medication allergies, 
and diagnostic test 
results), among providers 
of care and 
patient authorized entities 
electronically. 

Performed at least one test of 
the certified EHR technology’s 
capacity to electronically 
exchange key clinical 
information. 

Practice will need to sign up for Microsoft® 
HealthVault™.  
Patient must give TRAKnet™ permission to 
upload CCDs. 
From patient’s chart click File > Export > 
Continuity of Care Document (CCD) > For 
HealthVault™… 
Practice must save the file in a shared CCD 
export folder (stored in the TRAKnet™ PM 
export folder on the server). 
Start-up service must be installed on practice’s 
server by BioMedix™ Customer Service. 
Service will run the upload process upon start-
up and every 24 hours afterwards. 
CCD must be uploaded to HealthVault™ to 
meet this requirement. 

170.302(o) Protect 
electronic health 
information created or 
maintained by the 
certified EHR technology 
through the 
implementation of 
appropriate technical 
capabilities. 

Conduct or review a security risk 
analysis in accordance under 45 
CFR 164.308(a)(1) and 
implement security updates as 
necessary and correct identified 
security deficiencies as part of 
its risk management process. 

This must be done manually and outside of 
TRAKnet™ PM. However, TRAKnet™ PM 
provides access control and authentication, 
automatic log-off, audit log, integrity (i.e. SHA-
1), and encryption of data at rest and in motion 
to ensure that protected health information 
remains safe and secure. Completed at each 
office using a HIPAA Manual. 
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Meaningful Use Criteria − Menu 
 

   Menu Set of 10 Measures 
   Select 5 measures, 1 must come from the Public Health/Population Improvements. 
 

OBJECTIVE: 

Improving Quality, Safety, Efficiency, and Reducing Health Disparities 
Criteria Measure TRAKnet™ PM Qualifying Feature Set 
170.302(b) Drug formulary 
checks. 

The EP has enabled this 
functionality and has access to at 
least one internal or external drug 
formulary for the entire EHR 
reporting period. 

TRAKnet™ PM is Surescripts certified and has 
the ability to check formularies from 
Pharmacy Benefit Managers (PBMs) to see if a 
drug is approved, and if not, what the 
therapeutic alternatives are. 

170.302(h) Incorporate 
laboratory test results. 

More than 40 percent of all clinical 
lab test results ordered by the EP 
for patients admitted during the 
EHR reporting period whose 
results are either in a 
positive/negative or numerical 
format are incorporated in 
certified EHR technology as 
structured data. 

TRAKnet™ PM has the ability to import lab 
results from vendors using HL7 and record 
the results as discrete data within each 
patient’s chart. 

170.302(i) Generate 
patient lists. 

Generate at least one report 
listing patients of the EP with a 
specific condition. 

TRAKnet™ PM can create, display, print, and 
export lists of patients based on data 
elements in demographics, medications, 
diagnoses, or lab results. 

170.304(d) Patient 
reminders. 

More than 20 percent of all unique 
patients 65 years or older or 5 
years old or younger were sent an 
appropriate reminder during the 
EHR reporting period. 

TRAKnet™ PM can create, display, print, and 
export lists of patients based on data 
elements in demographics, medications, 
diagnoses, or lab results for the purpose of 
sending reminders regarding preventive 
and/or follow-up care. 

OBJECTIVE: 

Engage Patients and Families in their Healthcare 

Criteria Measure TRAKnet™ PM Qualifying Feature Set 
170.302(m) Patient specific 
education resources. 

More than 10 percent of all unique 
patients seen by the EP are 
provided patient-specific 
education resources. 

Within TRAKnet™ PM, patient education 
links can be created for diagnoses, 
medications and lab tests.  These links are 
then displayed, when applicable, and can be 
provided to patients at time of care. 

170.304(g) Timely access. More than 10 percent of all unique 
seen by the EP are provided timely 
(available to the patient within 4 
business days of being updated in 
the certified EHR technology) 
electronic access to their health 
information subject to the EP’s 
discretion to withhold certain 
information. 

TRAKnet™ PM has partnered with 
Microsoft® HealthVault™ to allow patients to 
access their health record information 
electronically in a timely manner. 
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    Menu Set of 10 Measures (continued) 
 

OBJECTIVE: 

Improve Care Coordination 

Criteria Measure TRAKnet™ PM Qualifying Feature Set 
170.302(j) Medication 
reconciliation. 

The EP performs medication 
reconciliation for more than 50 
percent of transitions of care in 
which the patient is transitioned 
into the care of the EP. 

TRAKnet™ PM has the ability to perform 
medication reconciliation for patients as well 
as the ability to record that medication 
reconciliation was performed when receiving 
patients from other providers. 

170.304(i) Exchange 
clinical information and 
patient summary record. 

The EP who transitions or refers 
their patient to another setting of 
care or provider of care provides a 
summary of care record for more 
than 50 percent of transitions of 
care and referrals. 

To record transitions of care within 
TRAKnet™ PM, incoming and outgoing 
provider referral orders can be created.  As 
part of this order, a Continuity of Care 
Document (CCD) can be provided as an 
attachment to reflect the summary of care for 
the patient during that transition. 

OBJECTIVE: 

Improve Population and Public Health 

Criteria Measure TRAKnet™ PM Qualifying Feature Set 
170.302(k) Submission to 
immunization registries. 

Performed at least one test of the 
certified EHR technology’s 
capacity to submit electronic data 
to immunization registries and 
follow-up submission if the test is 
successful (unless none of the 
immunization registries to which 
the EP submits such information 
have the capacity to receive such 
information electronically). 

TRAKnet™ PM can record immunizations for 
patients and transmit immunization history to 
other systems using HL7. 

170.302(l) Public health 
surveillance. 

Performed at least one test of 
certified EHR technology’s 
capacity to provide electronic 
syndromic surveillance data to 
public health agencies and follow-
up submission if the test is 
successful (unless none of the 
public health agencies to which 
the EP has the capacity to receive 
such information electronically). 

TRAKnet™ PM can record electronic 
syndromic surveillance data and transmit the 
information to other systems using HL7. 
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For more information 

 
 

Toll free:  877-854-0014 
info@BioMedix.com 

 
 

https://www.cms.gov/EHRIncentivePrograms 
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